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PeerlLock Server v4.0 H=] E3

File Options View Action Help

| Start @ | | options | &

F | Job MName | Source | Target | Locks | Lock Average | Rele; «
Q'_) 1  January Projects | D:'Projects\January V\dellt1500'ds\Projects'January 3 (3 Active) 0.53permin 0
&_} 2 Global Projects E:\Projects\Data Y\dellt1500'ds\Projects'Data 6 (6 Active) | L.O6permin 0
& 3  Peerlock Job 3 C:'Program Files (x86)\PeerLock\source  C:\Program Files (x86)\PeerLock\target 0 (0 Active) 0.00 permin 0
- Al Jobs 9 (9 Active) 1,59 permin 0
4 | »
Add | Update | Delete I Job Configured by PeerSync Profile: ReleaseCandidate.snd W | Local Jobs: 1 ‘ I | Linked Jots: 2

Locked Files: 9 |Released Files: 0 |

Target File Path Locked Duration Accessed B Detection T Sour... | Target s«
Wdellt1500\ds\Projects\DataProjectl - C... 2142013 12:4.., 00:05:37 MonikaC File Server M.,. Read... Read
Vdellt1500\ds\Projects\DataProjectd - C... 2142013 12:4... 00:05:37 MonikaC File Server M... Read. .. Read
Wdellt1500\ds\Projects\January Wew Micr..,  2/14/2013 12:4.., 00:05:37 MonikaC File Server M.,. Read... Read
Wdellt1500\ds\Projects\DataProjectl.docx 2142013 12:4... 00:05:35 MonikaC File Server M... Read... Read
V\dellt1500\ds\Projects\Data\Projectl - C... 2142013 12:4... 00:05:36 MonikaC File Server M... Read... Read
V\dellt1500\ds\Projects\Data\Project2.ppte 2142013 12:4...  00:05:38 MonikaC File Server M.,. Read... Read =
4 | »
Messages: 0 Running - Active Locks: 9

The manufacturer of PeerLock makes no warranties, implied or otherwise, for use of this product. User assumes all
responsibility for any data loss or damage.
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1.1 Getting Started

Welcome to PeerlLock. This product secures a user's files across a network of machines,
ensuring that all copies of the files are locked while the user is working with the file. This
security protects against multiple revisions occurring simultaneously on different machines.

How It Works

When a user opens a file in a watched folder, the corresponding target file is immediately
locked on the other machines specified in the user selection list. Other users cannot make
modifications to this file. When the user closes the file, the files residing on the other
machines are immediately unlocked, and can now be used to make changes. PeerLock is
designed to work with our PeerSync and Save-N-Sync products as to offer a total locking
and synchronization solution.

Configuration
When using PeerlLock specific environments will require certain options to be enabled/

disabled. Each environmentis unique and may require modifying the default options through
the interface or by using Command Line Arguments. For more help on how to configure
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PeerLock for your environment please visit the support section on our website at http:/
www.peersoftware.com/supporthtml.

PeerLock Installations and Registration

PeerlLock is shipped (downloaded) in a full installation program. To run, simply double click
on the executable file from the explorer (or choose Start Menu Run option and the select the
application).

Evaluation copies do not require user information and passwords. Registration copies
require you to enter a Registration Key into the Register Software Screen. When purchased,
Peer Software will send the Authorization Key required to unlock PeerLock's Evaluation. This
key is to be entered during the installation of the software.

If this is an unregistered or evaluation copy of PeerLock, you can register it with Peer
Software, Inc. as a fully licensed copy by providing credit card information via phone or
secure Internetregistration, or by sending a check or money order to the address below (see
included "readme.ixt" file for pricing information).

Register online via secure internet credit card registration at http://www.peersoftware.com

Register by phone via creditcard by calling:
703-763-7700 between the hours 0f 9:00 AM and 5:00 PM EST

Register by mail, send check or money orderto:
Peer Software, Inc.

5900 Fort Drive, Suite 415

Centreville, VA 20121

Upgrade Information

As new updates/changes become available, updated versions of the software will be
posted on our web page http://www.peersoftiware.com. Check this page periodically to
download the latest executables. Your Authorization Key will continue to work with updated
versions unless a major release is issued, or PeerLock is installed in a different folder than
the previously installed/authorized version. Please refer to the WhatsNew and/or ReadMe
files shipped with the PeerLock installation for the latest upgrade information.

Product Support

All support of PeerLock will be handled on our website (http://www.peersoftware.com)
supportpage for this product.

Terms And Conditions

Read License agreementbefore using this program.
Suggestions, Comments, or Requests for Support:
Peer Software, Inc.

5900 Fort Drive, Suite 415

Centreville, VA 20121
Phone: 703-763-7700
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FAX: 703-763-7705
Email: support@peersoftware.com

The manufacturer of PeerLock makes no warranties, implied or otherwise, for use of this product. User assumes alll
responsibility for any data loss or damage.
Copyright © 1993-2013 Peer Software Inc. All Rights Reserved Privacy Policy

PeerlLock is a registered trademark of Peer Software, Inc.
Reproduction in whole or in part without permission is strictly prohibited.

PeerLock Help Manual was built on Wednesday, February 13, 2013

1.2 Main Menu

File Options Wiew Action Help

File Menu

Save Defaults Once selected, this option stores out all the interface settings or
changes to the Configuration file.

Shortcuts This menu item allows you to create a shortcut either on the
Desktop or Startup folder. The /AM command line argument
will be appended to this shortcut so that PeerLock will
automatically start when launched from the shortcut.

Service Provides ability to Install and Uninstall the PeerlLock service as
well as ability to open the Services dialog. To start the
PeerLock service, close the PeerLock application, open the
Windows Services dialog, right-click on the PeerLock Utility
Software item and select Start. Be sure PeerLock is configured
to run under a Domain Administrator account that has full
access to all the source and targetresources.

E xit This menu item will terminate PeerlLock.

Options Menu

Lock Options... This menu item will open the Lock Options dialog.

Release Options... This menu item will open the Release Options dialog.
Performance... This menu item will open the Performance dialog.

Product Interaction... | This menuitem will open the Product Interaction dialog.
Includes/Excludes... This menu item will open the Includes/Excludes dialog.
Internal File This menu item will open the Internal File Managementdialog.
Management
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mailto:support@peersoftware.com
http://www.peersoftware.com/our-privacy-policy.asp

PeerLock Help

Reporting

This menu item will open the Reporting dialog.

All Global Option

Displays the Global Options dialog which shows all the above
dialogs in a tabular formatfor easy access.

View Menu

Tray Icon Provides ability to hide/show the Tray Icon. By default the Tray
Icon is displayed at runtime when PeerLock has been started
and is in a running state.

Toolbar Provides ability to hide/show the Toolbar. By default the

Toolbaris displayed.

Selection List

Provides ability to hide/show the Selection List. By default the
Selection Listis displayed.

Status Bars

Provides ability to hide/show the Selection List Status Bar and
the Lock/Release List Status Bar. By default these status bars
are shown.

Folders

Provides ability to Create and View the source and target
folders of the current selections. If the folders do not exist,
PeerLock will create them. This option will tile the folders on the
left side of the screenin an orderly fashion.

Log File

Provides a quick way to View and Clear the currentlog file.

Messages

Opens the Messages dialog to view any messages that have
occurred during the current operation.

Action Menu

Selections

Provides ability to Add, Update, and Delete a Job/
selection. These options are also available from the
Selection List Status Bar and the Selection List Popup
Menu.

Auto Start

When enabled PeerLock will be started and begin the
locking process automatically when the user interface is
started. By default Auto Startis disabled.

Start

When clicked PeerLock will begin the locking process.
Close the PeerLock application in order to start the
service.

Stop

When clicked PeerLock will end the locking process and
release all the handles it currently has on the targetfiles.

Release All Locks

PeerLock will release the lock handles of all the files
currently locked on the target folders. When using this
option the target files will not enter the Idle period before
being released. If using Local Detection, the target
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files will be permanently released. The source files
would need to be closed and re-opened for the lock
handles to be re-applied to the target files. When using
Server Detection, the target files will be temporarily
released. If atthe next Lock Frequency interval PeerLock
detects that the source files are opened, it will re-apply
the lock handles to the target files. Once an item is
released itwill be added to the Release list.

Note: Starting with version 3.0, PeerLock supports File Server Mode
Detection only.

Help Menu

PeerLock Help

Opens this Help File.

Online Resources

Provides links to various online resources such as support
documentation, guidelines for collaboration configuration, link
to our online support forum, and other useful website links.

Create System Info
File on Desktop

Allows you to create a system info file (Sysinfo.nfo) thatyou can
submitto our supportteam for troubleshooting purposes.

Register PeerLock

Opens the Registration window to view or modify the PeerLock
activation key/license.

About PeerLock

Opens the About screen for a summary view of the current
PeerLock version/build and provides access to the
Registration dialog.

Evaluation Menu (Available only during evaluation/trial modes)

Register PeerLock

Opens the Registration window to view or modify the PeerLock
activation key/license.

About PeerLock

Opens the About screen for a summary view of the current
PeerLock version/build and provides access to the
Registration dialog.

Notes:

1. Options and Action features can be set via Command Line Arguments.

2. For more information on Options and Action features see Command Line Arguments.

3. The Create/ View and Close Folder Selections in MS Windows Explorer features are only available in the Server

Edition of PeerLock.

4. Service features are only available in the Server Edition of PeerLock.

5. If you install PeerLock Server as a service, you must configure it to use an account that has access to all folder
selections (i.e. a domain\ admin account).
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6. If you install PeerLock Server as a service, you can still run it as an application but you should run only one

instance (Application or Service) at a time.

1.3 Toolbar

‘E | Start @ |JDpﬁuns |@
Toolbar Iltems
The Toolbar section allows you to quickly access most o f the commonly used menu
items. This section can be viewed/hidden by selecting/unselecting it under the View Main
Menu item.
Save Settings Allows you to save the current application settings as the
default settings.

Start Allows you to startthe current selections.
Stop Allows you to stop the current selections.
Options Provides quick access to the Global Options dialog.
Help Allows you to access this help file.

1.4  Selection List

1.4.1 Overview
Job Mame | Source | Target | Exdude Files
January Projects  D:'Projects\January \\dellt1500'ds\Projects\January | ~;*. tmp; . TMF;.PSTMR; . PSBAK; . EXE; . BAT;.CMD;. 5Y5;.
Global Projects E:'Projects\Data \\dellt1500'ds Projects\Data w3 tmp; TMP; . PSTMP; PSBAK; EXE; BAT;.CMD; . 5Y5;.

<Double-Click Here to Add a Selection>
.| | ol
Add pdate | elete I Job Configured by PeerLock ¥ Local Jobs: 0 Iv Linked Jobs: 2

Selection List Columns

The columns displayed on this panel can be shown/hidden by choosing Column
Selections... from the Selection List Popup Menu. You may also reposition the columns
simply by dragging them to a desired position. The Selection List can be shown/hidden
via the View menu. The default columns are Source, Target, and Sub-folders.

Source Displays the folder that you wish to monitor for files that are
opened.

Target Shows the folder or a list of folders where the files that you wish
to be locked upon a source file openreside.

Sub-folders Displays the option to watch just the root of the folder (Off) or to
include sub-folders of your Source and Targetselection (On).

Include Shows the masking of the types of files you wish to include.

Copyright © 1993-2013 Peer Software Inc. All Rights Reserved
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File types are specified by a star command followed by the file
extension (i.e. *.doc;*.txt, etc.). The default setting ( * ) includes
all files. Multiple Inclusions will be semi-colon delimited.
Inclusions are notcase sensitive,i.e. A =a.

Exclude Shows the masking of the types of files you wish to exclude.
File types are specified by a star command followed by the file
extension (i.e. *.doc;*.ixt, etc.). Multiple Exclusions will be semi-
colon delimited. Exclusions are notcase sensitive,i.e. A =a.

Source Connect As Displays the usermame (if any) specified to allow PeerLock
connection to the source directory that is not accessible using
the currentlogged on account.

Target Connect As Displays the username (if any) specified to allow PeerLock
connection to the target directory that is not accessible using
the currentlogged on account.

Notes:

1. Please refer to Product Editions for Selection Limits.

2. PeerLock allows for 255 Source Selections with each allowing for up to 100 Targets.

3. Folders can be dragged and dropped from MS Windows Explorer into these fields.

4. The drop-down lists will be dynamically populated with source-target folders, as they are set.

5. You can delete items from drop-down lists by dropping the list and selecting the item and pressing the delete key.
6. UNC names can be entered manually, or can be selected from the Network Neighborhood.

7. UNC names will appear in the form: \\ COMPUTER\ SHAREDDEVICE\ PATH

1.4.2 Status Bar

Add | Update Delete I

Job Configured by Peerlock ¥ Logal Jobs: 0 ¥ Linked Jobs: 2

Selection List Status Bar Iltems

Provides the ability to Add, Update, and Delete source and targetfolder entries.

Add This button will display the Add Selection Screen where you
can select a source and target folder list, and the ability to
include sub-folders.

Update Displays the Update Selection Screen where you can edit the
source and target folder listand the ability to include sub-
folders. This button is enabled when a Selection List item is
selected.

Delete Delete the selected item from the Selection List. This button is
enabled when a Selection Listitem is selected.

Selection Count Display ofthe currentselection count.

Copyright © 1993-2013 Peer Software Inc. All Rights Reserved
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Status

1.4.3 Add Selection Screen

PeerLock Server v4.0 - Add Selection =]

Folder Selection INetwork Logan I Exceptions |

older Selection
Source: |C:'|Program Files (x88)\PeerLock\source j _I
Target: IC:'lPngram Files (x&86)\PeerLodk\target j _I
¥ Indude sub-folders

Add Cancel Help

Folder Selection

This screen is used to add a new selection. By default this selection contains a source
and target sub-folder of the installed folder with Include sub-folders enabled and a
mask that includes all files. You can access this screen via the Action --> Selections -->
Add menu item, by double clicking the <Double-Click Here to Add Selection> item in
the Selection List, by right- clicking on the Selection List and selecting Add from the popup
menu, or by clicking on the Add button located on the Selection List Status Bar.

Source You may select a Source folder by typing the file path into the
field provided, dragging and dropping from MS Windows
Explorer into the field provided, or by using the Select Source
Button to the right of this field. All source folder selections must
reside on the local machine.

Click on the brows button to the right of this field to navigate to
the desired Source directory: once this box has opened, locate
your chosen Source folder, selectit using the left mouse button,
and click "OK", or by double-clicking the Source field. This
selection requires that the machine on which PeerlLock is
running has full access to the desired source directory.

Target You may select a Target folder by typing the file path into the
field provided, dragging and dropping from MS Windows
Explorer into the field provided, or by using the Select Target
Button to the right of this filed. For multiple target selections use
a semi-colon delimiter as depicted above.

Copyright © 1993-2013 Peer Software Inc. All Rights Reserved
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For remote Target locations we recommend providing the
UNC paths to the desired locations.

Click on the brows button to the right of this field to navigate to
the desired Targetdirectory: This button will display a 'Target
Folder Selection' dialog that will allow you to add targets. To
add a Targetfolder, click New, then type the desired Target
folder into the field located at the bottom of the dialog, or you
may use the browse for folder button. This button opens a
"Browse for Folder" dialog box: once this box has opened,
locate your chosen Targetfolder, select it using the left mouse
button, and click "OK." Repeat this process for each desired
target folder. Target folders can be deleted by selecting them
from the list and clicking the Delete key at the bottom of the
dialog box. Once you have finished, click the OK button. The
dialog will close and all of the Target folders you have
specified will automatically appear in the Target field in the
properformat(separated by semi-colons).

This selection requires that the machine on which PeerSync is
running has full access to the desired Targetdirectory. In some
instances Network Logon may be required.

Include sub-folders

Option to enable/disable the including of sub-folders of for the
current selection.

Notes:

1. Please refer to Product Editions for Selection Limits.

2. PeerlLock allows for 255 Source Selections with each allowing for up to 100 Targets.

3. Folders can be dragged and dropped from MS Windows Explorer into these fields.

4. The drop-down lists will be dynamically populated with source-target folders, as they are set.

5. You can delete items from drop-down lists by dropping the list and selecting the item and pressing the delete key.

6. UNC names can be entered manually, or can be selected from the Network Neighborhood.

7. UNC names will appear in the form: \\ COMPUTER\ SHAREDDEVICE\ PATH

Copyright © 1993-2013 Peer Software Inc. All Rights Reserved
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144 Update Selection Screen

PeerLock Server v4.0 - Update Selection =] E3
Folder Selection |Network Logon I Exceptions |
older Selection
Source: IC:'l,Users j _I
Target: I'l.'»,'Ser\-'er 1\CS\Users;V\server2\CS\Wsers j
¥ Indude sub-folders

Update Cancel Help

Folder Selection

This screen is used to update an existing selection. You can access this screen via the
Action --> Selections --> Update menu item, by double clicking an existing item, by right-
clicking on the Selection List and selecting Update from the popup menu, or by clicking
on the Update button located on the Selection List Status Bar.

Source You may select a Source folder by typing the file path into the
field provided, dragging and dropping from MS Windows
Explorer into the field provided, or by using the Select Source
Button to the right of this field. All source folder selections must
reside on the local machine.

Click on the brows button to the right of this field to navigate to
the desired Source directory: once this box has opened, locate
your chosen Source folder, selectit using the left mouse button,
and click "OK", or by double-clicking the Source field. This
selection requires that the machine on which PeerLock is
running has full access to the desired source directory.

Target You may selecta Target folder by typing the file path into the
field provided, dragging and dropping from MS Windows
Explorer into the field provided, or by using the Select Target
Button to the right of this filed. For multiple targetselections use
a semi-colon delimiter as depicted above.

For remote Target locations we recommend providing the
UNC paths to the desired locations.

Click on the brows button to the right of this field to navigate to
the desired Targetdirectory: This button will display a 'Target

Copyright © 1993-2013 Peer Software Inc. All Rights Reserved
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Folder Selection' dialog that will allow you to add targets. To
add a Targetfolder, click New, then type the desired Target
folder into the field located at the bottom of the dialog, or you
may use the browse for folder button. This button opens a
"Browse for Folder" dialog box: once this box has opened,
locate your chosen Targetfolder, select it using the left mouse
button, and click "OK." Repeat this process for each desired
target folder. Target folders can be deleted by selecting them
from the list and clicking the Delete key at the bottom of the
dialog box. Once you have finished, click the OK button. The
dialog will close and all of the Target folders you have
specified will automatically appear in the Target field in the
properformat(separated by semi-colons).

This selection requires that the machine on which PeerSync is
running has full access to the desired Targetdirectory. In some
instances Network Logon may be required.

Include sub-folders Option to enable/disable the including of sub-folders of for the
current selection.

Notes:

1. Please refer to Product Editions for Selection Limits.

2. PeerlLock allows for 255 Source Selections with each allowing for up to 100 Targets.

3. Folders can be dragged and dropped from MS Windows Explorer into these fields.

4. The drop-down lists will be dynamically populated with source-target folders, as they are set.

5. You can delete items from drop-down lists by dropping the list and selecting the item and pressing the delete key.
6. UNC names can be entered manually, or can be selected from the Network Neighborhood.

7. UNC names will appear in the form: \\ COMPUTER\ SHAREDDEVICE\ PATH

Copyright © 1993-2013 Peer Software Inc. All Rights Reserved
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145 Exceptions
PeerLock Server v4.0 - Update Selection =] E3

Folder Selection | Network Logon  Exceptions I

rIndude Files

—Exdude Files

I.'I'MP,'.PSTMP,'.PSB.-'-\K;.EX'E;.BAT;.CMD;.SYS;.DLL;NJ | |

rExdude Folders

I'lPSLOCK'l,

{lpdate Y cancel Help

Exceptions

Provides ability to selectfiles/folders to be included/excluded atthe Job/Selection level.

Include Files

Select an inclusion by typing file types into the field provided,
dragging and dropping files from MS Windows Explorer into
the field provided, or by using the button to the right of this filed.
Formultiple selections use a semi-colon delimiter.

The button to the right of this field will display a selection dialog
that will allow you to add inclusions. To add an inclusion, click
New then type the desired string (i.e. *.doc) into the field
located at the bottom of the dialog. Repeat this process for
each desired strings. Strings can be deleted by selecting them
from the listand clicking the Delete button at the bottom of the
dialog box. Once you have finished, click the OK button. The
dialog will close and all of the strings you have specified will
automatically appear in the Include Files field in the proper
format (semi-colon delimited).

Exclude Files

Enter an exclusion by typing file types into the field provided,
dragging and dropping files from MS Windows Explorer into
the field provided, or by using the button to the right of this filed.
For multiple selections use a semi-colon delimiter.

The button to the right of this field will display a dialog that will
allow you to add file exclusions. To add an exclusion click
New then type the desired string (i.e. *.doc) into the field
located at the bottom of the dialog. Repeat this process for
each desired exclusion. Strings can be deleted by selecting
them from the list and clicking the Delete button at the bottom

Copyright © 1993-2013 Peer Software Inc. All Rights Reserved



PeerLock Help 13

of the dialog box. Once you have finished, click the OK button.
The dialog will close and all of the strings you have specified
will automatically appearin the Exclude Files field in the proper
format (semi-colon delimited).

Exclude Folders Enter a folder exclusion by typing the folder names or paths
into the field provided, dragging and dropping the folders from
MS Windows Explorer into the field provided, or by using the
button to the right of this filed. For multiple selections use a
semi-colon delimiter.

The button to the right of this field will display a dialog that will
allow you to add folders. To add an exclusion click New then
type the desired string (i.e. System32) into the field located at
the bottom of the dialog. Repeatthis process for each desired
exclusion. Folders can be deleted by selecting them from the
list and clicking the Delete button at the bottom of the dialog
box. Once you have finished, click the OK button. The dialog
will close and all of the folders you have specified will
automatically appearin the Exclude Folders field in the proper
format (semi-colon delimited).

Hint: Dragging and dropping files and folders onto the desired include/ exclude fields is the fastest way to specify
exceptions. Dragging and dropping the files/ folders on these fields will cause PeerLock to dynamically enter only the
file extensions or folder names in the specified field. Dragging and dropping the files/ folder on top of the button to
the right of these fields will cause PeerlLock to enter the full name of the files or the full path of the folders.

1.4.6 Network Logon

PeerlLock Server v4.0 - Update Selection H=E

Folder Selection  Metwork Logon |Excepﬁons |

Source Network Logon Settings

Connect As: I j

Password: I

rTarget Network Logon Settings

Connect As: I j

Password: I

{“Update ||  Cancel Help

Source Network Logon Settings

Provides the ability to connect to a source folder that may require a different account then
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the one PeerlLock is running under.

Provide the user name to allow PeerLock connection to the
source directory thatis notaccessible using the current logged
on account. Be sure to include the domain name if applicable
(i.e. MyDomain\UserName).

Connect As

Password Enter the password information for login.

Target Network Logon Settings

Provides the ability to connect to a target folder that may require a different account then
the one PeerLock is running under.

Connect As

Provide the user name to allow PeerLock connection to the
target directory that is not accessible using the current logged
on account. Be sure to include the domain name if applicable
(i.e. MyDomain\UserName).

Password

Enter the password information for login.

Message Dialog

PeerLock Messages
File Options

L7]x]

Messages: 1

Could Not Lock File

Wdellt1500'\d$\Projects\January \New Microsoft Excel Worksheet. xlsx (The process cannot access the file because it s being ...

Max Count: |25 j

Date:  24/20031:00:06 Ak [13 Inztancesz]
Detall.  The system cannot find the file specified

Message Dialog

operation.

on that message.

The message dialog displays any messages that have occurred during the current
You can specify the Max Count by selecting this value for the amount of
messages to retain. You may also view the date and details for each message by clicking

Message Count

This is the number of "unique" messages being displayed. If a
message is reported more than once, the number of instances
will be specified atthe end of the 'Date’ field.

Max Count

This is the maximum number of messages that the dialog will
retain.

File Menu
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Close Message
Dialog

Selecting this option will close the Messages dialog. To
reopen the Messages dialog, click on the Messages label
located on the Lock/Release List Status Bar.

Terminate Application

This menu item will terminate PeerlLock.

Options Menu

Auto Display

Allows you to turn On/Off the Auto Display option. If Auto
Display is enabled, the Messages dialog will be shown
automatically when an error occurs,.

Show Icon on Tray

Provides ability to hide/show the Tray Icon. By default the Tray
Icon is displayed at runtime when PeerLock has been started
and is in a running state.

Clear Message List

Selecting this option will remove all messages shown in the
Messages list.

Log File

Provides a quick way to View and Clear the currentlog file.

Show Application

When running PeerLock in a minimized state, not visible, the
Messages dialog should show up automatically by default
and messages are received, selecting this option from the
Messages dialog will open the PeerLock application.

1.4.8 Selection List Popup Menu

Select Columns. ..

Add
Update
Delete

Folders 3

Selection List Popup Menu

Display the Selection List Popup Menu by right-clicking on the Selection List, This menu
canonly be accessed while PeerLock is notin a running state.

Select Columns...

Displays a dialog from which you can choose to show/hide
specific Selection List columns. The Source and Target
columns will be displayed at all times and cannot be hidden.
You can hide/show the entire Selection List by disabling /
enabling the Selection List item within the View menu.

Add Use this option to add a new selection. The Add Selection
Screen will be shown to guide you through the source/target
folder selection process.

Update Use this option to update an existing selection. The Update
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1.5
151

Selection Screen will be shown to guide you through the

source/targetupdate process.

Delete

Provides ability to delete the currentselection.

Folders

Provides ability to open and display the source and target
folders of the current selection. If the folders do not exist
PeerlLock will create them. It also gives you the ability to close
all opened source and targetfolders of the current selection.

Global Options
Lock Options

PeerLock Server v4.0 - Global Options

Lock Options | Release Options I Performance | Product Interaction I IndudesExdudes | Internal File Managementl Reporting |

I[= E3

rLock Frequency

Check for locked source filles every: |1 [ vI second(s)

rTarget File Options

[v Create target Stub file when target file does not exist (create folders if they do not exist)

rLodk Type to Apply to Target
[~ Allow Mo Access
[~ Allow Read Access

W Allow Access based on Source File

Ok I Cancel Help

Lock Frequency

Check for locked
source files every x
second(s)

Represents the interval, in seconds, of how often PeerLock will
check for locked source files. Once PeerLock detects that a
source file is locked it will lock the corresponding target files.
Defaultvalue is every 1 second.

Target File Options

Create target Stub file
when target file does
not exists (create
folder if they do not
exist)

Ifthe opened source file does nothave a corresponding target
file, by default, this option will cause PeerLock to create a 0
size stub file on the remote target location(s). PeerLock will
create the folder on the target if it does not exist. The stub file
will be removed/cleared upon release of the source file. When
using PeerSync with this option enabled, the stub file will be
excluded by PeerSync. This feature will prevent files from
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being added to the target while its corresponding source file is
open.

Turning off this option will cause PeerLock to add the file to the
Locked Files list, create PSTMP files on both the source and
target locations, but will not create a 0 size stub file as well as
folders.

Lock Type to Apply to Target

Allow No Access

PeerLock will use an exclusive handle to lock the
corresponding targetfiles. This method will completely lock out
users from accessing the targetfiles.

Allow Read Access

PeerLock will allow Read access for all locked target files.
This method will allow user to open files ina Read Only mode.

Allow Access based
on Source File
(Default)

PeerLock will take into account the source file access and
replicate the same exact handles to the target files. PeerLock
will apply the same type of handle to the target file that is
currently applied to the source file. This method will lock out
users from the target file in the same fashion they are locked
out from the source. This option is beneficial when working with
applications that allow for various types of file access (i.e.
some files are opened for read and write access while other
related files will be opened forread only access).

When using this feature, if the type of source lock is modified
by the application maintaining the lock, PeerLock will reassign
the new type of lock to the target file without releasing the file
from the Locked list. Also, if there are multiple locks on the file
PeerLock will merge or combine the lock type permissions
together to use one complete lock to apply to the
corresponding targetfile(s).

This option is enabled by default.

Note: Global Options settings apply to all Jobs/ Selections.
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15.2 Release Options

PeerLock Server v4.0 - Global Options I [=]

Lock Options Release Options |PerFormar|ce | Product Interaction I IndudesExdudes | Internal File Managementl Reporting I

Release Freguency
Check for released source files every: |3 [ vI second(s)
Pre Release Options

Set Idle time before releasing files to: |3 [ vI second(s)

Post Release Options

¥ Trigger Event on Release of Files
% Reapply Source Modified Tme = Update Source Modified Time
I™ Indude Manually Released Files
™ Indude files that have not been updated (Source Modified Time has not changed)

Ok I Cancel Help

Release Frequency

Check forreleased Represents the interval of how often PeerLock will check that
source files every x the locked source files are still in a locked state. Once
second(s) PeerLock detects that a locked source files has been

released PeerlLock will release the corresponding target file or
enter the Idle state. Once anitem is released itwillbe added to
the Release list. The defaultvalue is every 3 seconds.

Pre Release Options

Setldle time before Represents the interval of how long the target file will remain
releasing files to x locked once the source file has been released. When the
second(s) source file is closed PeerLock will wait x seconds before

releasing the target file. During this period the file entry in the
Locked list will be highlighted Yellow. This feature is intended
to protect the releasing of files during file opens and saves.
Certain applications may temporary release files during these
procedures. With this feature enabled PeerLock will wait the
set period oftime to make sure the file is fully released before
unlocking the corresponding target files. Once an item is
released itwill be added to the Release list. The default value
is every 5 seconds.

Post Release Options

Trigger Eventon If the source file was been modified/updated while it was
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Release of Files

opened, PeerLock will re-apply the original modified date/time
stamp to the source file once it is closed/released. This
method will trigger an update event to be detected by
PeerSync.

Reapply Source
Modified Time

If the source file was been modified/updated while it was
opened, PeerLock will apply the currentdate/time stamp to the
source file once itis closed/released. This method will trigger
anupdate eventto be detected by PeerSync.

Update Source
Modified Time

If a file was manually forced to be released, this method will run
through the process of triggering an event on the source file
(based on which of the trigger events are selected). By default
this option is disabled because we don't want to cause a
trigger eventifthe source file may still be opened.

Include Manually
Released Files

This option will allow for triggering of files that have been
manually released. By default this setting is disabled.

Include files that have
not been updated
(Source Modified
Time has not
changed)

This option will allow for triggering of files that may have been
open butnotupdated. By default this setting is disabled.

Note: Global Options settings apply to all Jobs/ Selections.

1.5.3 Performance

PeerLock Server v4.0 - Global Options H=E

Lock Options I Release Options  Performance IPrcduct Interaction I IndudesExdudes | Internal File Managementl Reporting I

Application Priority Selection

| |
1 i
Lowy

High

rEvent Thread Settings

Set Access Event Thread Count to: |5 [ vi
Set Access Event Thread Timeout to: |3U [ vi second(s)

r—Advanced Performance Settings
Set Processor Affinity (CPU Bit Mask): |1 [#] Use only CPU 0

Skip check for locked source files if: |5 [ vi events are pending

Ok

Cancel | Help I

Application Priority Selection

Move the slider to adjust the PeerLock application priority. To achieve faster PeerLock
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response rate move the slider to the right. To achieve lower CPU usage move the slider to
the left. Each slider position represents the following values:

Sleep Frequency Sleep Value

Slider Position 1 10 100

Slider Position 2 25 50

Slider Position 3 50 25

Slider Position 4 100 10
Event Thread Settings
Set Access Event Specify the number of threads used to detectand lock opened
Thread Count to files. This feature improves the detection and locking of

opened files and overall responsiveness of PeerLock.
Increase this value if you want PeerLock to have more threads
available forlocking files. Default value is 5.

Set Access Event The Timeoutsetting is used to determine for how long to leave
Thread Timeout to inactive threads running for. Default value is 30 seconds.

Advanced Performance Settings

Set Processor Affinity | This setting will allow you to limit which CPUs to use in a multi-
(CPU Bit Mask) processor environment.

Skip check for locked | Adjustperformance by performing source lock validation
source files if x checks only when x events are pending.
events are pending

Note: Global Options settings apply to all Jobs/ Selections.
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15.4 Product Interaction

PeerLock Server v4.0 - Global Options I [=]

Lock Options I Release Options I Performance  Product Interaction | Indudes Exdudes | Internal File Managementl Reporting I

21

rProduct Interaction Options
v Interact with PeerSync
W Interact with Remote PeerLocks

rPeer Administrator Options
[~ Send Status to Peer Administrator

rMicrosoft Office User Information

[~ Indude User Lock Information for Microsoft Office Files i.e. Word, Excel and PowerPoint)

Ok Cancel | Help I

Product Interaction Options

Interact with PeerSync

If this option is checked PeerLock will interact with other
PeerSyncs by excluding their corresponding temporary files
from being locked (i.e. *.pstmp, *.brtmp).

Interact with Remote
PeerLocks

If this option is checked PeerLock will interact with other
PeerLocks by excluding their corresponding temporary files
from being locked (i.e. *.pslock).

Peer Administrator Options

Send Status to Peer
Administrator

Check this optionin order for PeerLock to begin sending status
information to the Peer Administrator. By default this option is
disabled.

Microsoft Office User Information

Include User Lock
Information for
Microsoft Office Files

Enable this option in order for Microsoft Office files to display
the name of the user who has the original file opened on
another site. Without this option enabled, Microsoft Office files
will show "another user" instead of the user name. The name
used in this option is the one used in Microsoft Office (File >
Options > General > User name) for the users opening the file
from the client systems.

Note: This setting is available only as part of PeerSync - Collaboration Edition
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(bundle of PeerSync + PeerlLock).

Notes:

1. If one of the above options are checked PeerLock will create a hidden temporary system file in the target
directory (*.pslock).

2. Global Option settings apply to all Jobs/ Selections.
155 Includes/Excludes

PeerLock Server v4.0 - Global Options I [=]

Lock Options I Release Options I Performance | Product Interaction  Indudes/Excludes IInternaI File Managementl Reporting I
—Applications to Indude and Exdude

Incude: I= j _I

Exdude: ITASKMGR.F_‘{E,'FASTFIND.B{E,‘RTVSCAN.B{E;OFMNT.E‘&'E;NAUAPSUC.E‘&'E;NMI'AF‘W3Z.EX'E,'BLACI{[CE.E‘&'E;BLACKD.E{E,‘PEEIj |

rUsers to Indude and Exdude
Iﬂdude:l‘ ﬂ _I
Exdude: I j _I

Mote: It is recommended to run PeerLock and PeerSync with a user account that will not be collaborating on files and to add that user
account to the Users Exdude list. The current user account running PeerLock is: MonikaC

0K Cancel | Help I

Applications to Include and Exclude

The Include/Exclude window is accessible from the Options Menu. This dialog allows you
to select applications or users to include and/or exclude from the event detection used to
determine open source files.

Include Use this field to determine which applications to include in the
event detection used to determine open source files. The
default setting (*) includes all applications. Multiple Includes
can be wused and are semicolon delimited (i.e.
WINWORD.EXE;EXCEL.EXE). Includes are not case sensitive,
ie. "A" = "a". Includes can be typed manually, or can be
specified using either the drop-down list located or the Include
Applications Button to the right of the field.

Include Applications Opens an "Include Applications" dialog box into which
Button application names may be entered. To add an application to
include, click "New", then type the desired application name
into the field located at the bottom of the dialog. Repeat this
process for each desired application to include. Includes can
be deleted by selecting them from the list and clicking the
"Delete" key at the bottom of the dialog box. Once you have
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finished, click the "OK" Button. The dialog will close and all of
the Includes you have specified will automatically appear in
the Include Applications field in the proper format (separated
by semicolons).

Exclude

Use this field to determine which applications to exclude in the
event detection used to determine open source files. The
default setting includes a list of applications that may trigger
unwanted detection. Multiple Excludes can be used and are
semicolon delimited (i.e. EXPLORER.EXE;PeerLock.EXE).

Excludes are not case sensitive, i.e. "A" ="a". Excludes can
be typed manually, or can be specified using either the drop-
down listlocated orthe Exclude Applications Button to the right

of the field.

Exclude Application
Button

Opens an "Excludes Applications" dialog box into which
application names may be entered. To add an application to
exclude, click "New", then type the desired application name
into the field located at the bottom of the dialog. Repeat this
process for each desired application to exclude. Excludes
can be deleted by selecting them from the list and clicking the
"Delete" key at the bottom of the dialog box. Once you have
finished, click the "OK" Button. The dialog will close and all of
the Excludes you have specified will automatically appear in
the Exclude Applications field in the proper format (separated
by semicolons).

Users to Include and Exclude

The Users to Include/Exclude window is accessible from the Options Menu. This dialog
allows you to specify the users to include and/or exclude from the event detection used to
determine open source files.

Include

Enter the names of the users for which you want PeerLock to
detect opened files. The default setting (*) includes all users.
Multiple Includes can be used and are semicolon delimited
(i.e. JOES;MARYK). Includes are not case sensitive, i.e. "A" =
"a". Includes can be typed manually, orcan be specified using
either the drop-down list located or the Include Users Button to
the right of the field.

Include Users Button

Opens an "Include Users" dialog box into which user names
may be entered. To add a user to include, click "New", then
type the desired name into the field located atthe bottom of the
dialog. Repeatthis process foreach user to include. Includes
canbe deleted by selecting them from the list and clicking the
"Delete" key at the bottom of the dialog box. Once you have
finished, click the "OK" Button. The dialog will close and all of
the Includes you have specified will automatically appear in
the Include Users field in the proper format (separated by
semicolons).
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Exclude Enter the names of the users for which you want PeerlLock to
exclude opened files. The default setting is blank and will not
exclude any users. Multiple Excludes can be used and are
semicolon delimited (i.e. JOES;MARYK). Excludes are not
case sensitive, i.e."A" ="a". Excludes can be typed manually,
or can be specified using either the drop-down list located or
the Exclude Users Button to the right of the field.

Example: You may choose to exclude files that are opened
by the Administrator since activity generated under this
account is typically non user related and does not need to be
reacted on. Doing so will increase performance in PeerLock
by filtering out unnecessary activity. For optimal performance
we recommend you exclude the user account under which
PeerLock and/or PeerSync are running.

Exclude Users Button | Opens an "Exclude Users" dialog box into which user names
may be entered. To add a user to exclude, click "New", then
type the desired name into the field located atthe bottom of the
dialog. Repeatthis process foreach userto exclude. Exclude
canbe deleted by selecting them from the list and clicking the
"Delete" key at the bottom of the dialog box. Once you have
finished, click the "OK" Button. The dialog will close and all of
the Excludes you have specified will automatically appear in
the Exclude Users field in the proper format (separated by
semicolons).

Note: Global Option settings apply to all Jobs/ Selections.
1.5.6 Internal File Management

PeerlLock Server v4.0 - Global Options ==
"Lock Options I Release Options I Performance | Product Interaction I Indudes/Exdudes Internal File Management IReporting I
ache Management
[V Cache Locked File History
[ Cache Released File History

[V Clear Cache at Start Clear Cache |

Ok Cancel | Help I
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Cache Management

Provides ability to track and remove temporary files used by PeerlLock.

Cache Locked File
History

Maintains a list of all the files locked by PeerlLock in the
PeerlLock installation folder (..\PeerLock\Cache\LFCache txt).
If the Clear Cache at start option is enabled, at the start-up of
PeerLock, it will refer to this list to clean up the stub files and
lock files left behind on the target folder. Alternatively this can
be done manually by hitting the clear cache button. This setting
is enabled by default.

Cache Released File
History

Maintains a list of all the files released by PeerlLock in the
PeerLock installation folder (..\PeerLock\Cache\LFCache.ixt).
If the Clear Cache at start option is enabled, at the start-up of
PeerlLock, it will refer to this list to clean up the stub files and
lock files left behind on the target folder. Alternatively this can
be done manually by hitting the clear cache button. This setting
is enabled by default.

Clear Cache at Start

Clears out the cache file located in the Cache folder in the
PeerlLock installation folder when PeerlLock is starting and
begins to lock files down. This setting is enabled by default.

Note: Global Option settings apply to all Jobs/ Selections.

15.7 Reporting

PeerLock Server v4.0 - Global Options I [=]
Lock Options I Release Options I Performance | Product Interaction I IndudesExdudes | Internal File Management Reporting |
eporting
¥ On: IC:'IPROGRAN2'|PeerLDdc'|,|.ogs'lPeerLoda.log jil

Set Maximum Log File Size to |1D485}"6 |3, Bytes View | Clear |
Set Number of Backup Files to IlD |3.

oK cancel ||{ Help

Reporting

All known information at the time ofan eventis logged ina tab delimited format with column
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into a spread sheet.

headers for the start and stop of a PeerLock locking session. This allows for easy import

On

Selecting and turning this option On/Off will enable/disable log
file reporting. Once checked, select a log file by typing the file
pathinto the field provided, or by using the search button to the
right. By default, the log file field will use the path in which the
application has been installed: in most cases this will be
'C:\Program Files\PeerLock' and will assume a default log file
name such as PeerlLock.log.

Set Maximum Log File
Size to x Bytes

Allows you to specify the maximum size of the log files to be
created.

Set Number of
Backup Files to x

Allows you to specify the amount of backup log files to be
created. If you set the number of backup log files to 0 then at
the time your log file reaches its maximum size it will be deleted
and recreated on the next log entry. If you set the number of
backup log files to a value of 1.n then when your log file
reaches its maximum size it will be renamed to a file with the
extension .bak plus the number the backup file is. Example:
Setting the number of backup log files to 2 will produce the
following log files:

LogFileName.log (newest information)
LogFileName.bak1
LogFileName.bak2 (oldestinformation)

View When this is selected the log file will be displayed in the default
texteditor.

Clear When this is selected the log file will be cleared. The entire
contents of the log file will be deleted leaving behind only an
empty file.

Notes:

1. The drop-down lists will be dynamically populated with log file names, as they are set.

2. Files can be dragged and dropped from MS Windows Explorer into the 'Reporting’ field.

3. Global Option settings apply to all Jobs/ Selections.
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1.6 Lock/Release List
1.6.1 Locked List

Locked Files: 8 |Released Files: 10 |

27

Target File Path I Locked I Duration I Accessed By | Detection Type I Sour... | Target Acce
Vdellt15300\ds\Projects\January\Mew Micr...  2/14/2013 1:22... 00:05:09 MaonikaC File Server M...  Read... Read
Vdellt1500\ds\Projects\January\Mew Micr...  2/14/2013 1:22... 00:05:09 ManikaC File Server M...  Read... Read
Vdellt1500\d$\Projects JanuaryMew Micr...  2/14/2013 1:22.,. 00:05:05 MonikaC File Server M... Read... Read
Videllt1500\ds\Projects\Data\Projectl - C... | 2/14/2013 1:26... 0:0L:17 ManikaC File Server M...  Read... Read
Videllt1500'\ds\Projects\Data \Project2 - C...  2/14/2013 1:26,..  00:01:07 MonikaC File Server M.,., Read... Read
V\dellt1500'\ds\Projects\Data'\Projectl - C...  2/14/2013 1:26...  00:00:56 MonikaC File Server M...  Read... Read
\\dellt1500\d4\Projects\Data \Project - C...  2/14/2013 1:27...  00:00:35 MonikaC File Server M... Read... Read
'|,'|,Ic|e||t1SDD\,ds'l,Drojecis'l,Data'l,Projeth.ppb( 2142013 1:27... [ 00:00:33 MonikaC File Server M... Read... Read _I
4 4

Locked List Columns

This panel contains all information captured about the source and target files that have
been locked. The columns displayed on this panel can be shown/hidden by choosing
Column Selections... from the Lock List Popup Menu. You may also reposition the columns
simply by dragging them to a desired position. The default columns are Target File Path,
Locked, Duration, Accessed By, Target Access Mode, and Source File Path.

#Locks

Displays the number oflocks on the source.

Accessed By

The name ofthe user who has opened the file or accessed the
resource.

Application

Displays the application that has been detected as opening
the source file.

Detection Type

This column represents the PeerLock detection mode used to
detectwhatsource files are locked/opened. This will either be
File Server Mode Detection orLocal Detection.

Note: Starting with version 3.0, PeerLock supports File Server Mode
Detection only.

Duration Displays the amount of time that the source file has been
opened.
Idle Time Shows the amount of time the targetfile will remain locked once

the source file has been released. When the source file is
closed PeerlLock will wait the number of Idle Time seconds
specified before releasing the target file. During the Idle Time
period the file entry in the Locked listwill be highlighted Yellow.
The Idle Time value can be setin the Release Options dialog.
This feature is intended to protect the releasing of files during
file opens and saves. Certain applications may temporary
release files during these procedures. With this feature
enabled PeerLock will waitthe set period of time to make sure
the file is fully released before unlocking the corresponding
targetfiles.

Lock File Handle

Displays the handle value created that is being used to lock
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the temporary Lock File created by PeerLock to Interact with
other Peer Software Products. If the Interact features are
disabled then this will display 'None'.

Locked Display the date/time when the targetfile was locked.

Release Detected Shows the date and time when PeerLock detected the source
file was closed. This value will be cleared if the file is reopened
within the Idle period and the targetfile handle is not released.

Source Access Displays the permissions that are allowed on the opened
Allowed source file.

Source Attributes Shows the attributes of the source file.

Source File Path Displays the file name complete with folder path for the source

file thathas been detected as an openfile.

Source Handle Displays the handle value created when the source file was
opened.
Source Modified Shows the modified date/time of the source file when it was

detected as being open.

Source Open Mode Displays the permissions that were used to open the source
file.

Target Access Displays the permissions that are allowed on the opened

Allowed targetfile which are applied by PeerLock.

Target File Path Shows the file name complete with folder path for a target file

thatis locked, if the file exists and can be locked.

Target Handle Display the handle value created thatis being used to lock the
targetfile by PeerLock.

Target Open Mode Displays the permissions thatwere granted when the target file
was locked by PeerlLock.

Temporary Releases | Shows the number of times the source file was closed during
the Idle period.

1.6.2 Released List

Locked Files: 0 Released Files: 10 I

Target File Path | Released | Duration | Accessed By | Detection Type | Source Open M... | Target Access ... | |~
Videllt1500\ds\P... 2/14/2013 1:21... 00:05:55 ManikaC File Server M...  Read+Write+Atrib  Read 0
Videllt1500\ds\P..,  2/14/2013 1:21... 00:05:55 MonikaC File Server M.,, | Read+Write+Atrib  Read 0
Videllt1500\ds\P...  2/14/2013 1:21... 00:05:55 MonikaC File Server M... | Read+Write+Atrib | Read 0
Videllt1500\ds\P...  2/14/2013 1:21... 00:05:55 MonikaC File Server M... | Read+Write+Atrib | Read 0
V\dellt1500\dS\P...  2/14/2013 1:21...  00:05:57 MonikaC File Server M... | Read-+Write+Atrib | Read 0
Vdellt1500\ds\P... 2/14/2013 1:21... 00:05:57 ManikaC File Server M...  Read+Write+Atrib  Read 0 =
Vdellt1500\ds\P... 2/14/2013 1:21... 00:05:57 ManikaC File Server M...  Read+Write+Atrib  Read i}
Videllt1500\ds\P... 2/14/2013 1:21... 00:06:01 ManikaC File Server M...  Read+Write+Atrib | Read illl
. | »

Released List Columns
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This panel displays a list of the top 100 recently released files and all information
pertaining to the locking and releasing ofthose files including why the file was released (i.e.
Manually, Locking Stopped, PeerLock Stopped or the Source File was released). The
columns displayed on this panel can be shown/hidden by choosing Column Selections...
from the Lock List Popup Menu. You may also reposition the columns simply by dragging
them to a desired position. The default columns are Target File Path, Locked, Duration,
Accessed By, Target Access Mode, and Source File Path.

#Locks Displays the number oflocks on the source.

Accessed By The name of the user who has opened the file or accessed the
resource.

Application Displays the application that has been detected as opening

the source file.

Detection Type This column represents the PeerLock detection mode used to
detectwhatsource files are locked/opened. This will either be
File Server Mode Detection orLocal Detection.

Note: Starting with version 3.0, PeerLock supports File Server Mode
Detection only.

Duration Displays the amount of time that the source file has been
opened.
Idle Time Shows the amount of time the targetfile will remain locked once

the source file has been released. When the source file is
closed PeerLock will wait the number of Idle Time seconds
specified before releasing the target file. During the Idle Time
period the file entry in the Locked listwill be highlighted Yellow.
The Idle Time value can be setin the Release Options dialog.
This feature is intended to protect the releasing of files during
file opens and saves. Certain applications may temporary
release files during these procedures. With this feature
enabled PeerLock will waitthe set period of time to make sure
the file is fully released before unlocking the corresponding
targetfiles.

Lock File Handle Displays the handle value created that is being used to lock
the temporary Lock File created by PeerLock to Interact with
other Peer Software Products. If the Interact features are
disabled then this will display 'None'.

Locked Display the date/time when the targetfile was locked.

Release Detected Shows the date and time when PeerLock detected the source
file was closed. This value will be cleared if the file is reopened
within the Idle period and the targetfile handle is not released.

Source Access Displays the permissions that are allowed on the opened
Allowed source file.
Source Attributes Shows the attributes of the source file.
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Source File Path Displays the file name complete with folder path for the source
file thathas been detected as an openfile.

Source Handle Displays the handle value created when the source file was
opened.

Source Modified Shows the modified date/time of the source file when it was

detected as being open.

Source Open Mode Displays the permissions that were used to open the source
file.

Target Access Displays the permissions that are allowed on the opened

Allowed targetfile which are applied by PeerLock.

Target File Path Shows the file name complete with folder path for a target file

thatis locked, if the file exists and can be locked.

Target Handle Display the handle value created thatis being used to lock the
targetfile by PeerlLock.

Target Open Mode Displays the permissions that were granted when the target file
was locked by PeerlLock.

Temporary Releases | Shows the number of times the source file was closed during
the Idle period.

1.6.3 Lock/Release List Popup Menu

Select Columns. ..

Release: Wdellt1500'\d$\Projects\Data\Project 2. pptx
Release All Locks

Gdd " nknown® ta Application Exclude List

Indudes/Exdudes...

Log File r

Messages...

Lock List Popup Menu

Display the Lock/Release List Popup Menu by right-clicking on the Lock or Release panel.

Select Columns... Displays a dialog from which you can choose to show/hide
specific Lock or Release list columns. At least one column
mustbe shown atall times.

Release PeerLock will release the lock handle of the currently selected
targetfile. When using this option the targetfile will not enter the
Idle period before being released. If using Local Detection,
the target file will be permanently released. The source file
would need to be closed and re-opened for the lock handle to
be re-applied to the target file. When using Server
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Detection, the target file will be temporarily released. If at the
next Lock Frequency interval PeerLock detects that the source
file is opened, it will re-apply the lock handle to the target file.
Once anitemis released itwill be added to the Release list.

Note: Starting with version 3.0, PeerLock supports File Server Mode
Detection only.

Release All Locks

PeerLock will release the lock handles of all the files currently
locked on the target folders. When using this option the target
files will not enter the Idle period before being released. If
using Local Detection, the target files will be permanently
released. The source files would need to be closed and re-
opened for the lock handles to be re-applied to the target files.
When using Server Detection, the target files will be
temporarily released. If at the next Lock Frequency interval
PeerlLock detects that the source files are opened, it will re-
apply the lock handles to the target files. Once an item is
released itwill be added to the Release list.

Note: Starting with version 3.0, PeerLock supports File Server Mode
Detection only.

Add x to Application
Exclude List

Provides a quick way to exclude/include an application from
triggering an event detection used to determine open source
files. This option will cause PeerlLock to restart.

Application Include/
Exclude Lists...

Opens an Application Include/Exclude dialog box into which
application names may be entered to be excluded/included
from triggering an event detection used to determine open
source files. PeerLock would need to be restarted for any
change to take effect.

Log File Provides quick access to View the log file as well as ability to
Clearit.
Messages... Opens the Message dialog to display any messages that

have occurred during the currentoperation.

1.6.4 Lock/Release List Status Bar

Messages: 1 ‘

Running - Active Locks: 7

Lock/Release List Status Bar

This bar can be shown/hidden via the View menu.

Messages

By clicking on the messages label you can view the Message
dialog for more information about the messages you are
receiving. When there are new messages, the label color will
change to Red, once the message is viewed the label color
will be resetto Black.

Center Status Display

Displays information/messages when connecting to machines.
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This section will contain information about connection attempts
and Retry Failed Connections.
Active Lock Count Shows the status of PeerLock. It will display 'Inactive’ if
PeerLock is notconfigured and or setto start.
1.7 Other Features
1.7.1 Shortcuts
Add to Desktop Ctrl+D
Add to Startup Folder  Cirl45
Show Startup Folder
Shortcuts
Command Line Arguments may be applied through a shoricut or the Configuration file. To
create a shortcutfrom the interface and access the command line you wantyou can:
1. Setup the Job you wish to run and run it from the interface.
2. Go to the File > Shortcuts menu
3. SelectAdd to Desktop orAdd to Startup Folder
4. Rightclick on the Shortcutand selectProperties
5. Go to the Target field and view/copy the command line string. For example: The
following arguments are appended to the end ofthe command line followed by a space
and forward slash (i.e. /A’). A space and forward slash are also used to separate each
additional argument (i.e. /A/DC+).
1.7.2 Configuration File

,' PLDef.cfg - Notepad
File Edit Format View Help

=] E3

[Product]

AppLevel=2

Name=PeerLock Sserver v4.0
version=4.0
Compiled=February 13, 2013
Platform=winNT
Winoir=C:"windows

|

[AppInfo]

wWindow State=Normal
Left=68

Top=362

Width=750
Height=450

Use Skins=1

<

Check for File Name In Caption - Process Names=notepad.exet+Notepad;mspaint.exe+Pair

-

| vl s

CFG File

This file is located in the PeerLock installation folder by default (C:\\Program Files
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\PeerLock\PLDef.cfg).

By default PeerlLock stores all of its settings in a configuration file called PLDef.cfg.
This file may be modified with a text editor but doing so is not recommended. Also,
you can load from an alternate configuration file by adding a file name that has a *.cfg
extension to your command line (i.e. MyPLConfig.cfg).

1.8 Command Line Arguments

1.8.1 Command Line Arguments

The applications Command Line Mode offers users the ability to configure a truly "hands-off"
installation, where operation and distribution occurs from within an easily manageable,
administrative environment. This mode allows Actions to be executed from logon scripts,
system batch orcommand (CMD) files, detailed shortcuts, and shell commands.

Notes:
1. For the command line arguments described in this topic, note that attention is paid to punctuation, to the order in

which arguments are entered, and that appropriate spaces are used to separate these arguments. Follow the
format outlined in the examples provided.

2. Command Line Arguments can be added to the application Shortcut

Auto Start
/A
Auto Start: This argumentis used to start PeerLock automatically.
[AM
Minimized*: This argumentis used to run PeerLock automatically and minimized.
Examples:
/A Auto Start
[AM Auto Start - Minimized

Detect/Lock Options
/DC[+-]

Check For File Name In Caption: Looks for the source file name in all open
application captions when deciding if a file is open or not. This optionis on by default.

[DE[+-]

Strip File Extension (Check For File Name In Caption): When using the Check For
File Name In Caption option this option will strip off the file extension when looking for file
names in all open application captions.

[DP[+-]

Strip File Path (Check For File Name In Caption): When using the Check For File
Name In Caption option this option will strip off the file path when looking for file names in all
open application captions. This optionis on by default.
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/DD[+-]

Detect Files when Target Does Not Exist (Create Target Stub File): If the
opened source file does nothave a corresponding targetfile, PeerLock will create a 0 size
stub file on the remote target location(s). The stub file will be removed/cleared upon
release of the source file. When using PeerSync with this option enabled, the stub file will
be excluded by PeerSync. This feature will prevent files from being added to the target
while its corresponding source file is open. By default this option is enabled.

/DL+

Allow No Access: Uses an exclusive lock on target files, meaning once the lock is
applied no other applications can get a lock on the targetfile. This option is disabled by
default.

/DL-
Allow Read Access: The lock set on target files will allow for other applications to still
obtain a handle and gettheirown lock on the file. This optionis disabled by default.

/DL>

Allow Access based on Source File: PeerLock will take into account the source file
access and replicate the same exact handles to the target files. PeerLock will apply the
same type of handle to the targetfile thatis currently applied to the source file. This method
will lock out users from the target file in the same fashion they are locked out from the
source. This option is beneficial when working with applications thatallow for various types
offile access (i.e. some files are opened for read and write access while other related files
will be opened forread only access). This optionis enabled by default.

/DI +-

Interact with PeerSync and/or Save-N-Sync***: Communicates/Notifies PeerSync
and/or Save-N-Sync to exclude source files that are detected as open until the file has
been released. This option is off by default and the caption of the option will display the
name of the Peer Software productthatis installed if applicable.

[DJ[+-]

Interact with Remote PeerLocks***: Communicates/Notifies remote PeerlLocks that
may be running on your target machine(s) to exclude the detection of the local PeerLock
locking files on the remote machine. This option should be enabled when running
PeerLock on multiple machines pointing ateach other. This option is off by default.

/DO[+-]

Check for File Open On Detection: This open will validate for a false detection of an
openfile by doing a secondary validation that the file is open on detection of the open file.
This option is off by default.

/DS[+-]

Use File Server Mode Detection: If enabled, detection of locked files will be
monitored by connections to the server made from other machines. When this option is
enabled files opened by the local machine will not be detected but open files will be
detected and locked on the start of PeerLock. If this option is not enabled detection of
locked files will be monitored by a device driver running on the local machine the watches
for changes made by any machine including the local machine but open files will not be
detected and locked on the start of PeerLock. This optionis on by default.
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/DM:n

Set Detection Method Level (n = 1 - 31): PeerLock uses up to five methods of
detection to determine if a file is open and in use. Using a value between 1 and 31 will
enable any combination ofthe five methods. The first four methods are used by default (a
value of 15{1+2 +4 +7}). Each method is represented by 2 to the x value:

1=Method 1
2 =Method 2
4 =Method 3
8 =Method 4
16 = Method 5

[DT[+-]

Use Local Detection: Detectsource file open events thatoccurlocally. Changes will be
detected in Real-Time as source files are opened. Files opened priorto PeerLock running
will notbe detected. This option is disabled by default.

Note: Starting with version 3.0, PeerLock supports File Server Mode Detection only.

[DN[+-]

File Server Mode Detection: Detect source file open events that occur across the
network. lt will notdo real time detection as the Local Detection mode. It will poll opened
files from the Windows Open Files list based on the Lock Frequency. Therefore it will be
able to detect files that were opened prior to PeerLock being started. This option is
enabled by default.

Note: Starting with version 3.0, PeerLock supports File Server Mode Detection only.

Examples:
/DC-E+P+D+L+I-O-S+M15 Default Settings on servers
/DC-E-P-D-L-I-O-M31 All Options Off and All Detection Methods On

Release Options

/RS[+-]

Trigger Event: This option will check to see if the source file has been updated by
looking at the current modified date/time stamp versus the stored modified date/time
stamp. If the file has been updated PeerLock will trigger an event to be detected by
synchronization products to update the corresponding target file(s) with the updated source
file upon release from the Lock List.

/RA[+-]

Wait for Associated Application to Close: This option will check to see if the
application that opened the source file is still running before releasing the corresponding
targetfile(s) from the Lock List. This option is useful when an application does not retain a
handle on the files that are opened by itself. When this option is enabled, the target files
will not be released until all instances of the application terminate. By default some
application names are excluded from this check (i.e. Explorer.exe). The default exclusion
listfor this option can be modified by editing the configuration file (PLDef.cfg).
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/RF:n

Release Frequency (n = frequency in milliseconds): Sets the frequency to check
for source files thathave been closed orreleased. The defaultis every 3000 milliseconds
or 3 seconds.

[RLn

Set Release Idle Time: Represents the interval, in seconds, of how long the target file
will remain locked once the source file has been released. When the source file is closed
PeerLock will waitn seconds before releasing the targetfile. During this period the file entry
in the Locked list will be highlighted Yellow. This feature is intended to protect the releasing
of files during file opens and saves. Certain applications may temporary release files
during these procedures. With this feature enabled PeerlLock will waitthe set period of time
to make sure the file is fully released before unlocking the corresponding target files. Once
anitem is released itwillbe added to the Release list. The defaultvalue is 5 seconds.

/RT+
Trigger Event - Include files that have notbeen updated: This option will allow for

triggering of files that may have been open but not updated. By default this setting is
disabled.

/RL:n

Set Lock Frequency: Represents the interval, in milliseconds, of how often PeerLock
will check forlocked source files. Once PeerlLock detects that a source file is locked it will
lock the corresponding targetfiles. Default value is 1000 ms.

Examples:

/RS+A-F3000 Trigger Event On, Wait for Associated
Application to Close Off and Check for
Released Files every 3 Seconds (Default)

/RS-A+F1000 Trigger Event Off, Wait for Associated
Application to Close On and Check for
Released Files every 1 Second

Performance

/[PF:n

Service Thread Sleep Frequency: Represents the sleep frequency value, in
milliseconds, of the main service thread. The higher the frequency the more CPU will be
used. By default this value is 50 ms. To achieve faster PeerLock response rate, increase
the Sleep Frequency and decrease the Sleep Value. To achieve lower CPU usage,
decrease the Sleep Frequency and increase the Sleep Value.

[PR:n

Retry Failed Connections (n = frequency in milliseconds): PeerLock will store
failed connections and retry them on a ten minute cycle. This should improve overall
performance when connection losses occur.

Examples:

Ifn=0 Will check connection failures and not retry
until restarting the locking.

Ifn=-1 Will try to connect on every event. Only
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recommended to wuse when having
intermitted connection failures.
If n = other positive value Represents in milliseconds the retry
frequency.
Defaultis 60000 ms =every 10 minutes
Minimum value is 1000 ms =every 1 second
/PV:n
Service Thread Sleep Value: Represents the sleep value, in milliseconds, of the main
service thread. By default this value is 25 ms. To achieve faster PeerLock response rate,
increase the Sleep Frequency and decrease the Sleep Value. To achieve lower CPU
usage, decrease the Sleep Frequency and increase the Sleep Value.

Examples:

/PF50 Default Service Thread Sleep Frequency
/PV25 Default Service Thread Sleep Value
/PR60000 Default Retry Failed Connections setting

Internal File Management

[JL[+-

Cache Locked File History: Maintains a list of all the files locked by PeerLock in the
PeerlLock installation folder (..\PeerLock\Cache\LFCache txt). If the Clear Cache at start
optionis enabled, at the start-up of PeerLock, it will refer to this list to clean up the stub files
and lock files left behind on the target folder. Alternatively this can be done manually by
hitting the clear cache button. This setting is enabled by default.

[JS[+-]

Clear Cache At Start: Clears out the cache file located in the Cache folder in the
PeerLock installation folder when PeerLock is starting and begins to lock files down. This
setting is enabled by default.

Application Include/Exclude

/l:al;a2..an

Include Applications** (a = Applications to Include during Detection): This
argument is used to build a list of applications to Include during detection. For multiple
applications use a semi-colon delimiter. By defaultall applications are included. This can
also be configured from the interface via the Application Include/Exclude Lists.

Examples:

/:* Include detection of file opens from all
applications

/EWINWORD.EXE;EXCEL.EXE Include detection of file opens from MS Word
and MS Excel

[E:al;a2..an

Exclude Applications** (a = Applications to Exclude during Detection): This
argument is used to build a list of applications to Exclude during detection. For multiple
applications use a semi-colon delimiter. By default a list of applications are excluded
including Explorer, PeerLock, PeerSync and Save-N-Sync. This can also be configured
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from the interface via the Application Include/Exclude Lists.

Examples:
/E: Do notexclude any applications
/E:EXPLORER.EXE;PeerLock.EXE Only exclude PeerLock and PeerSync

Notes:

1. Any arguments containing spaces must be enclosed by quotes.

2. Most of these options can be set from the interface via the Main Menu.
3. * The run minimized argument is not available during evaluation.

4. ** By Observing at the Lock_List Application Column you can determine what applications you may want to
Include or Exclude.

1.9 Product Information

1.9.1 Product Editions/Licensing

Product Information

Will runon Servers

Allows up to 255 Source Selections

Allows up to 100 Targets per Source Selection
CanRunas a Service

Feature to Create/View and Close Folder Selections in
MS Windows Explorer

Features

Licensing PeerlLock can be licensed for single or multiple users.

A single user license, by default, comes with right to install/
execute the software on one PC and connect to one or more
remote PCs or unlimited local drives. A license must be
purchased for each PC where the product will be installed,
executed or launched. This also applies to Enterprise
installations that run the software off a network file server.

For more information about Product Levels and Licensing
please visitour web site: http://www.peersoftware.com

Note: Peer Software is quite flexible in assembling different combinations of option packages then the ones listed
here for enterprise installations with customers' requirements in mind. Please contact us for such requests and for
more detail of the PeerLock option packages that are available.

1.9.2 License

YOU SHOULD READ CAREFULLY THE FOLLOWING TERMS AND
CONDITIONS BEFORE INSTALLING, USING OR DISTRIBUTING THIS
SOFTWARE. INSTALLING, USING OR DISTRIBUTING THIS SOFTWARE
INDICATES ACCEPTANCE OF THESE TERMS AND CONDITIONS. IN THIS
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AGREEMENT, "YOU" MEANS YOU AS AN INDIVIDUAL IF YOU ARE USING
THIS SOFTWARE FOR PERSONAL USE. IF YOU ARE USING THE
SOFTWARE ON EQUIPMENT OWNED OR OPERATED BY A COMPANY OR
ORGANIZATION (COLLECTIVELY "COMPANY"), BY ACCEPTING THIS
AGREEMENT, YOU REPRESENT THAT YOU ARE DULY AUTHORIZED TO
ACCEPT THIS AGREEMENT ON BEHALF OF YOUR COMPANY.

COPYRIGHT

The software programs (hereafter the "Software") and documentation (hereafter the
"Documentation") is copyrighted and remains the property of Peer Software, Inc. All rights are
reserved.

LICENSE

Peer Software, Inc. hereby grants you (hereafter the "User") a limited, non-exclusive, non-
transferable license to install and use the Software and accompanying Documentation
contained in the trialware distribution package (hereafter called the "Trialware Package")
you received (THE "Original Distribution") for your internal business purposes only. The
Trialware Package consists of copies of the Software and Documentation received via an
electronic transfer mechanism or an electronic storage medium including, but not limited to,
diskette, hard disk, removable disk, tape or optical devices such as CD-ROM or WORM.
This license to install and use the Software and Documentation is conditioned upon User’s
compliance with the terms of this Agreement.

You may install and use the Trialware Package on one or more computers provided there is
no chance thatitwill be used simultaneously on more than one computer. If you need to use
the Software on more than one computer simultaneously or on a network, please contact
Peer Software, Inc. forinformation about network licenses.

The Software is protected by trade secret and copyright laws and international treaty
provisions. You are not obtaining title to the Software or Documentation or any copyright or
otherintellectual property rights. You further acknowledge thattitle and full ownership rights to
the Software and Documentation will remain the exclusive property of Peer Software, Inc. or
its suppliers, and You will not acquire any ownership rights to the Software. You may not
sublicense, lease, rent, sell, convey, translate, modify, decompile, incorporate into another
product, convert to another programming language, reverse engineer or disassemble the
Software or Documentation for any purpose. You may not modify, or create derivative works
based in whole orin partupon, the Software. You agree to notremove, obscure, or alter Peer
Software, Inc.’s or any third pary's copyright notice, trademarks, or other proprietary rights
notices affixed to or contained within or accessed in conjunction with or through the Software
and Documentation. Peer Software, Inc. reserves the right to periodically conduct audits
upon advance written notice to verify compliance with the terms of this Agreement.

Once a license is purchased from Peer Software, Inc., the Trialware Package will be
authorized to function as the full working version of the Software with access to all licensed
features.

NETWORK LICENSE
Multiple users on a network (e.g. a LAN) requiring access to the Software and Documentation

must purchase a Network License. Two forms of Network Licenses are offered, a Site
License and Enterprise or Concurrent User License. With a Site License, any user who
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accesses the Software or Documentation requires a user license, regardless of the
frequency of use. Once a Site License is purchased Software and Documentation may be
copied to all users who have been licensed. Site Licenses are customized for each
purchase. The license is based on a quantity of simultaneous users and or CPU installations.

The Concurrent User License allows the licensed number of users to simultaneously access
the Software and Documentation. The User agrees to operate metering software, which
restricts the simultaneous number of users to the quantity purchased. The Software and
Documentation mustbe installed on network servers under the control of metering software.

Both Site and Concurrent User Licenses allow installation of the Software and Documentation
to any number of servers on any number of geographic sites, limited only by the quantity of
licenses purchased.

TERM AND TRIAL PERIOD

You are permitted to use the Trialware Package for a trial period (hereafter the "Trial
Period") of thirty (30) days or 30 uses (which ever comes first) after receipt of the Trialware
Package. After such time, if you continue to use the Trialware Package, you must register
your copy with Peer Software, Inc. Failure to register after the Trial Period constitutes
termination of this license. Upon registration, a password (hereafter called the "Password")
will be provided to eliminate the registration reminder screen.

This license is effective until terminated. You may terminate it by destroying the Software,
Documentation, and all copies thereof. This license will also terminate if you fail to comply
with any of the terms or conditions herein. You agree, upon such termination, to destroy all
Software, Documentation, and copies thereof. Upon request, You agree to certify in writing
thatall copies of the Software and Documentation have been destroyed.

LIMITED WARRANTY

THE SOFTWARE AND DOCUMENTATION IS PROVIDED "AS IS"WITHOUT WARRANTY
OF ANY KIND. PEER SOFTWARE, INC. DISCLAIMS ALL WARRANTIES RELATING TO
THIS SOFTWARE, WHETHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT
LIMITED TO ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE, AND INFRINGEMENT AND ALL SUCH WARRANTIES ARE
EXPRESSLY AND SPECIFICALLY DISCLAIMED.

EXCLUSIVE REMEDY

YOUR EXCLUSIVE REMEDY AND PEER SOFTWARE, INC. ENTIRE LIABILITY ARISING
FROM OR IN CONNECTIONS WITH THE SOFTWARE, DOCUMENTATION, AND/OR
THIS LICENSE (INCLUDING WITHOUT LIMITATION FOR BREACH OF WARRANTY OR
INFRINGEMENT) SHALL BE, AT PEER SOFTWARE, INC.'S OPTION, THE REPAIR OR
REPLACEMENT OF THE SOFTWARE OR REFUND OF REGISTRATION FEES (IF
NOTIFICATION OF PROBLEM IS WITHIN 30 DAYS OF PURCHASE).

LIMITATIONS OF LIABILITY

UNDER NO CIRCUMSTANCES OR LEGAL THEORY, WHETHER IN TORT, CONTRACT,
OR OTHERWISE, SHALL PEER SOFTWARE, INC. OR ANYONE ELSE WHO HAS BEEN
INVOLVED IN THE CREATION, PRODUCTION, OR DELIVERY OF THIS SOFTWARE BE
LIABLE TO YOU OR TO ANY OTHER PERSON FOR ANY INDIRECT, SPECIAL,
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INCIDENTAL, OR CONSEQUENTIAL DAMAGES (EVEN IF PEER SOFTWARE, INC.
SHALL HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES), INCLUDING,
WITHOUT LIMITATION, DAMAGES FOR LOSS OF GOODWILL, WORK STOPPAGE,
COMPUTER FAILURE OR MALFUNCTION, OR, FOR ANY OTHER DAMAGES OR
LOSSES OF ANY NATURE.IN NO EVENT WILL PEER SOFTWARE, INC. BE LIABLE FOR
ANY DAMAGES IN EXCESS OF THE LIST PRICE PEER SOFTWARE, INC. CHARGES
FOR A LICENSE TO THE SOFTWARE.

Some states do not allow the exclusion of the limit of liability for consequential or incidental
damages, so the above limitation may notapply to you.

BACK-UP
You may make one copy ofthe Trialware Package forbackup purposes only.
DISTRIBUTION

You may distribute the Trialware Package to others via an electronic transfer mechanism or
electronic storage media provided that no files are deleted from the Original Distribution
Trialware Package or are modified in any way. Files may be added to the Trialware
Package expressly for the purpose of identifying the party distributing the Trialware
Package. You may also place the Trialware Package into any archive or compressed
formatfor ease of distribution.

You may notdistribute the product Registration Key to others under any circumstances.
GENERAL

Export of the Software may be subject to compliance with the rules and regulations
promulgated from time to time by the Bureau of Export Administration, United States
Department of Commerce, which restrict the export and re-export of certain products and
technical data. If the export of the Software is controlled under such rules and regulations,
then the Software shall not be exported or re-exported, directly or indirectly, (a) without all
exportorre-exportlicenses and United States or other governmental approvals required by
any applicable laws, or (b) in violation of any applicable prohibition against the export or re-
exportofany partof the Software. Some countries have restrictions on the use of encryption
within their borders, or the import or export of encryption even if for only temporary personal
orbusiness use. You acknowledge thatthe implementation and enforcement of these laws is
not always consistent as to specific countries. Although the following countries are not an
exhaustive list there may exist restrictions on the exportation to, or importation of, encryption
by: Belgium, China (including Hong Kong), France, India, Indonesia, Israel, Russia, Saudi
Arabia, Singapore, and South Korea. You acknowledge it is your ulimate responsibility to
comply with any and all government export and other applicable laws and that Peer
Software, Inc. has no further responsibility after the initial license to you within the original
country of sale.

In addition, neither the Software nor the Documentation and underlying information or
technology may be downloaded or otherwise exported or re-exported (i) into (or to a national
orresidentof) any country to which the United States has embargoed goods; or (ii) to anyone
on the United States Treasury Department's list of Specially Designated Nations or the
United States Commerce Department's Table of Denial Orders. By using the Software you
are agreeing to the foregoing and you are certifying that you are not located in, under the
control of, or a national or resident of any such country or on any such list.
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This agreement shall be governed by the laws of the state of New York and shall inure to the
benefit of Peer Software, Inc. and any successors, administrators, heirs, and assigns. Any
action arising under this Agreement shall be filed in any state or federal court located in
Suffolk county in the State of New York, and You hereby agree, acknowledge and submit to
the exclusive jurisdiction and venue of such courts for the purposes of such action, waive any
right You may have to objectto such jurisdiction or venue.

This Agreement sets forth all rights for the user of the Software and is the entire agreement
between You and Peer Software, Inc. and supersedes any other prior or contemporaneous
agreements or communications with respect to the Software and Documentation. This
Agreementmay notbe modified except by a writen addendum issued by a duly authorized
representative of Peer Software, Inc. No provision hereof shall be deemed waived unless
such waiver shall be in writing and signed by Peer Software, Inc. or a duly authorized
representative of Peer Software, Inc. If any provision of this Agreement is held invalid, the
remainder of this Agreement shall continue in full force and effect. The parties confirm that it is
their wish that this Agreement has been written in the English language only.
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